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1. Introduction

1.1. Background

The International Atomic Energy Agency (IAEA) provides general guidelines 
for assessing the dose of critical groups and populations based on the 
monitoring of radioactive materials and the environment during nuclear 
or radiological emergencies in nuclear and radiation-related facilities[1-3]. 
The purpose of environmental radiation monitoring is to provide 
information that can aid effective decision-making, such as prompt 
judgment in emergency situations and initiation of protective actions 
to safeguard emergency workers and the public. Therefore, in the event 
of an accident at a nuclear or other facility, environmental sampling 
and subsequent measurements are performed to provide data on 
the levels, time dependence, and spatial distribution of radionuclides 
in various environmental media (such as air, soil, plants, food, etc.) in 
order to assess the doses to critical groups and populations and to 
support decisions on protective and mitigation actions[1-3].

The emergency environmental monitoring program involves determining 
the types of environmental samples, collection points, radionuclides 
to be monitored, and the frequency of analysis[4]. The program varies 
based on the characteristics of the nuclear or radiological facility, site 
characteristics of the environment, type and magnitude of the accident, 
and the timing of monitoring. Depending on the type of accident, it 
may be necessary to prioritize the measurement of environmental 
media and radionuclides that have a greater environmental impact 
or are of greater exposure assessment significance. For instance, in 
reactor facilities, radioactive noble gases and oxides; in nuclear fuel 

facilities, uranium or plutonium released by fire, explosion, or leakage; 
and in criticality accidents, fission products, neutrons, and gamma rays. 
Therefore, in order to evaluate the radiation impact from the facility 
to the environment and detect unexpected situations, each country 
that operates the facility establishes and implements a radiation 
environmental monitoring plan during normal operation of the facility, 
and prepares for abnormal emissions and accidents by establishing 
radiation disaster prevention measures and emergency monitoring 
plans.

Table 1 summarizes the IAEA guidelines, which should be considered 
as a simplified framework for emergency monitoring. A unique 
program should be established that is appropriate for the operational 
characteristics of the facility in a given country, taking into account the 
site characteristics, emission levels, and relevant radionuclides. The 
intensity and duration of the monitoring activities should be determined 
by the severity of the emergency, which may range from a few days to 
several years. As the situation evolves, a phased monitoring program 
should be established.
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Table 1. �Environmental Monitoring of Radionuclides to be Performed 
Following Emergencies (IAEA RG-S-1.8)[4]

Release Monitored constituents Frequency Remarks
Airborne Measurements during the passage of a cloud

External radiation
Gamma dose rate

Neutron dose rate  
(if neutron radiation  
is foreseen)

Continuous

Continuous

Near and far field, 
external dose rate map
Only near field, if 
neutrons are expected

Air
Air

Rain

Continuous collection, 
measurement every 2 h
Continuous collection, 
measurement every 2 h

Near and far field

Near and far field

Measurements after the passage of a cloud In contaminated areas
External radiation

Gamma dose rate Continuous
external dose rate 
map

Deposition
Soil Once

Contamination 
map for relevant 
radionuclides

Foodstuffs/ingestion
Leafy vegetables

Milk

Other vegetables and 
fruits
Grain
Meat
Drinking water and/or 
ground water

Daily

Daily

At harvest

At harvest
Representative samples
Representative samples

Good indicator for 
plant food
Good indicator for 
animal food

Liquid After release Affected areas and 
water bodies are 
limited

Aquatic dispersion
Surface water

Sediment

Continuous sampling, 
daily measurement
Weekly

Aquatic foodstuffs
Fish
Shellfish

Selected samples
Selected samples

Aquatic indicators
Seaweeds Selected samples

Table 2. �Monitoring Quantities and Measurement Guidance 	
(IAEA RG-S-1.8)[4]

Quantity to be measured Sampling/measurement Application

Source monitoring
Gamma dose rate at  
the source

Stationary on-line 
equipment, continuous 
measurement

Practice, emergency

Gases in released air Stationary on-line equipment, 
continuous measurement

Practice, emergency

Aerosols in released air a On-line equipment and/or 
sampling; nuclide specific 
analysis, total alpha and 
total beta

Practice, emergency

Activity in released  
water a

On-line equipment and/or 
sampling; nuclide specific 
analysis, total alpha and 
total beta

Practice, emergency

Environmental monitoring
Gamma dose rate over 
ground

Field measurements; mobile 
or stationary devices

Practice, emergency, 
chronic (prolonged) 
exposure

Aerosol activity in air Filter sampling; nuclide 
specific analysis

Practice, emergency, 
chronic (prolonged) 
exposure

Radioiodine in air Sampling specific to physical 
and chemical form; nuclide 
specific analysis

Practice, emergency

Activity in rain Sampling in rain collector; 
nuclide specific analysis

Practice, emergency

Deposited activity In situ gamma spectrometry; 
planchet sampling and 
nuclide specific analysis

Practice, emergency

Activity in soil In situ gamma spectrometry; 
field sampling and nuclide 
specific analysis

Practice, emergency, 
chronic (prolonged) 
exposure

Activity in foodstuffs 
and feedstuffs, waters, 
sediment

Field sampling; nuclide specific 
analysis

Practice, emergency, 
chronic (prolonged) 
exposure

a If the discharge limits for a practice are given in terms of total alpha activity 
and/or total beta activity, and not for specific radionuclides, radionuclide 
specific measurements on a routine basis may not be necessary
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1.2. Objective

The aim of this handbook is to assist ASEANTOM Member States in effectively 
conducting radioactivity analyses of gamma-emitting radionuclides on 
environmental samples during nuclear and radiological emergencies. The 
handbook provides practical guidelines for the radioactivity analysis of 
gamma-emitting radionuclides in environmental samples, with a focus 
on laboratory analysis[5]. ASEANTOM Member States are recommended 
to establish procedures appropriate to the circumstances of their 
analytical laboratories in each country, based on this guide.

2. Considerations in radiological emergencies

2.1. Gamma-ray spectrometer

During normal times, radioactivity measurement devices for gamma-
emitting radionuclides should be deployed and prepared for use in the 
event of an emergency. It is crucial that these devices are capable of 
achieving the targeted measurement uncertainty despite need for fast 
measurements, as a large number of samples may need to be analyzed 
during an emergency. To prepare for environmental samples that may 
be contaminated with high levels of radioactivity during emergencies, 
appropriate measures must be taken. Additionally, it is essential to prepare 
for situations where there are insufficient samples from the environment.

2.2. Environmental sample collection

The collection of environmental samples must be based on the type of 
sample to be collected, with the aim of, ensuring that the collected samples 
are representative of the target sample. As a result, it is crucial to determine 
which parts of the environmental sample should be collected and how 
they should be collected, depending on the type of sample used.

2.3. Sample preparation

Samples collected from the environment and transported to the 
laboratory must be prepared for rapid measurement. This can be 
achieved by placing them in prescribed volumes in reference 
containers after minimal pretreatment. It is crucial to prevent cross-
contamination between samples and laboratory contamination, 
particularly contamination of measuring devices.

2.4. Measurement of Samples

In the case of an emergency, sample measurements are likely to be 
performed within a short period. However, it is essential to ensure 
that the target or requested measurement uncertainties are met. The 
uncertainty of measurements performed under normal conditions, such 
as calibration, is directly affected by the measurement time (spectral 
accumulation time).

2.5. Analysis of Measurement Results

In some cases, the results obtained by analyzing the spectra from 
the measurements of the samples may need to be corrected. To do 
so, correction factors for each contaminating radionuclide should be 
prepared for the selected measurement conditions.

2.6. Reporting results

To ensure that the measurement and analysis results are effectively 
utilized by relevant groups when making judgments, it is important to 
report them in accordance with metrological notations. Additionally, 
the recording and reporting should include details on sampling and 
measurement conditions.
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3. Measurement equipment

3.1. High-purity germanium (HPGe) detector

High-purity germanium (Ge) detectors are commonly employed to 
measure the radioactivity of gamma-emitting radionuclides in samples. 
To detect gamma-rays with energies higher than 30 keV, p-type Ge 
detectors are typically used. This is because, while measuring lower-
energy gamma rays, the X-rays generated during radioactive decay can 
cause coincidence summing with the gamma rays, which complicates 
post-measurement analysis. However, n-type detectors can also 
measure lower energies by placing an appropriate absorber between 
the detector and the sample to eliminate X-rays below a certain energy 
level.

To shield the detector from external radiation, it is necessary to install 
a shield around it. When placing the detector inside the shield, it is 
important to maximize the distance between the detector and the 
sample, as long as it does not compromise the external radiation 
shielding effectiveness. This will enable an appropriate relative dead 
time to be obtained, particularly in emergency situations involving 
highly contaminated samples.

Figure 1. (a) A shield installed with the detector, and (b) 
increased distance between the detector and the sample

(a) (b)

3.2. Containers for environmental samples

To ensure representativeness of the sample being measured, the 
container holding the sample must have a sufficient volume (e.g., soil in 
a particular area) when preparing it for measurement in the laboratory. 
If required, environmental samples can be homogenized adequately 
before measuring. However, even in highly contaminated samples, 
selecting unreasonably small sample volumes can compromise the 
representativeness of the measurement. For a typical case with low 
contamination levels, it is recommended to use a large container 
with a volume of 1 L or more to hold sufficient samples and optimize 
measurement efficiency. In emergency situations where contamination 
levels are high, and the relative dead time of the measuring device is 
outside the appropriate range (e.g., approximately 10%), the relative 
dead time can be reduced by increasing the distance between the 
detector and the sample.

For highly contaminated samples and situations where smaller 
amounts of samples are collected in the environment, it is advisable 
to select additional cylindrical containers that can hold approximately 
one-tenth of the sample volume of the large containers. 

Figure 2. Containers for environmental samples
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3.3. Calibration sources

When calibrating the measuring device, it is essential to use a 
radioactive certified reference material that has the same quantity as 
the measurement sample in the containers selected previously. The 
certificate supplied with the certified reference material should contain 
information such as the radionuclides present in the calibration source, 
the radioactivity of each radionuclide, and the level of uncertainty 
associated with the calibration.

Figure 3. Certified reference materials 

3.4. Sample holder

To ensure consistency in the measurement, a sample holder must 
be present inside the shield. This holder is used to position the 
calibration source or the prepared measurement sample under the 
same conditions (i.e., the same relative position of the sample with 
respect to the detector). It is recommended that the sample holder is 
located at the bottom of the shield to avoid exerting any direct force 
on the detector body. The sample holder must also be designed to 
return to the same position if temporarily removed for any reason. To 
prevent contamination of the inside of the shielding and the detector 

by the calibration source and measurement sample, it is crucial to ensure 
that the sample does not come into direct contact with the detector. To 
facilitate decontamination in case of partial contamination, the surface of 
the detector and shielding should be protected with plastic wrap. For the 
sample holder, it is advisable to use a plastic material with low density.

 
Figure 4. A sample holder made of plastic

4. Detector calibration

4.1. Selection of calibration source

The calibration of a gamma-ray spectrometer is crucial in identifying the 
energy of gamma rays emitted by an unknown radionuclide in a sample 
and in calculating the radioactivity concentration of the radionuclide 
in the sample from its count rate. To achieve accurate calibration, the 
calibration source must contain a sufficient level of radionuclides that 
emit gamma rays over the appropriate range of energies necessary for 
energy and efficiency calibrations of the detector. Typical calibration 
sources used for gamma-ray spectroscopy should contain radionuclides 
that emit gamma rays in the energy range 50–2000 keV, covering a wide 
range of gamma ray energies.

When the calibration source is not in the same medium as the measured 
sample, the self-attenuation effect of the sample must be corrected. This 
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should be longer for longer distances) to achieve the desired uncertainty.

 
Figure 5. �Calibration source and sample located at the same distance 

from the detector

Once the calibration source is selected and the detector-source distance 
(calibration point) is determined, the counts of each gamma ray of 
interest should be measured to ensure that they are sufficient to achieve 
the targeted calibration accuracy. The uncertainty of the measurement 
efficiency is mainly determined by the uncertainty of the certified 
reference material and the net count of each gamma ray of interest.

Figure 6. Spectrum of a calibration source

is because the gamma rays emitted by the radionuclide in the sample will 
be attenuated as they travel through the sample, reducing the count rate 
at the detector. Most calibration sources are produced and distributed 
only in water, which is not representative of all environmental media. 
Therefore, it is important to correct for the self-attenuation effect of the 
calibration source medium (usually water) and the measured sample 
medium using existing data or computer calculations.

When more than one sample container is used, and if the correction 
factor cannot be obtained with sufficient accuracy based on the target 
measurement uncertainty using computer calculations, a calibration 
source for each container should be prepared.

Each laboratory should have a quality control procedure for the 
detector, considering the characteristics of the detector and the 
measuring conditions. The quality control procedure should cover the 
operation of the detector, and include calibration and inspection.

4.2. Measurement of calibration source

If a calibration source with the same geometry and volume as the 
container required for sample preparation is available, the calibration 
should be at the selected detector-to-sample distance. The same 
calibration procedure should be repeated for other detector-to-sample 
distances using the same sample container. Additionally, calibration 
should be performed for other sample containers using the appropriate 
calibration sources to the containers, to the extent possible. In case 
a calibration source is not available, the measurement efficiency of 
the sample container and the detector-to-sample distance should be 
ensured through calculations such as computer simulations. When 
calibrating at different detector-to-sample distances using the same 
calibration source, the spectral accumulation times should differ (they 
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Figure 7. Energy calibration

Figure 8. Energy resolution

4.3. Energy calibration and energy resolution

The energy calibration procedure typically involves acquiring data 
using a calibration source that contains radionuclides emitting the 
gamma rays at known energies and correlating those energies with 
the multichannel analyzer (MCA) channels acquired by the data 
acquisition (DAQ) system. This requires using the reference data of 
the radionuclides[6] in the calibration source. The energy calibration 
procedure can be summarized as follows:

Energy calibration procedure

① Import a calibration source measurement spectrum
② �Build and apply a gamma-emitting radionuclide library for calibration 

using reference data
③ Delete existing calibration results, if necessary
④ Perform an energy calibration (automatically or manually)
⑤ View and save energy calibration results

The energy calibration curve is typically a straight line, as shown in the 
figure 7. The difference between the linear fit and the measured data 
should be within ±0.15% for satisfactory results. After completing the 
energy calibration, it is important to check the energy resolution (FWHM), 
which generally increases proportionally with energy. A difference 
between the energy-resolution fitting result and the measured data 
within ±2% is considered satisfactory. If the result is unsatisfactory, 
then the DAQ measurement signal should be tuned separately.
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Figure 9. Efficiency calibration

The following shows the model equation of efficiency calibration and 
uncertainty evaluation. The model equations can also be used to 
perform the calculations and can be applied to the efficiency calibration 
results.

Efficiency Calibration Model Equation

• Calibration Efficiency

• Net count correction factor

• Decay correction factor to the reference time, 

• True coincidence summing correction to k-gamma

 

4.4. Efficiency calibration

After completing energy calibration, the next step is to calibrate the 
gamma-ray detection efficiency of the HPGe detector. This requires data 
acquired from a calibration source, along with its calibration certificate, 
and a library file created during the energy calibration. The efficiency 
calibration procedure is as follows:

Efficiency calibration procedure

① Import the measured spectrum of the calibration source
② �Apply the radionuclide library of the calibration source created 

during energy calibration 
③ Verify that the radionuclides in a given peak are properly recognized
④ �Enter the reference date of the certificate, radioactivity of the 

radionuclide, and relative standard uncertainty of the radioactivity 
by considering the units on the certificate.

⑤ �Calculate peak efficiency by specifying an appropriate efficiency 
fitting curve function 

⑥ View and save efficiency curve fitting results

After the efficiency calibration, it is important to check the 
appropriateness of the efficiency fitting curve function and examine the 
difference between the calculated and fitted efficiencies. In cases where 
the calibration source contains gamma-emitting radionuclides with a 
true coincidence summing effect, it is necessary to correct the efficiency 
of the peak. The figure below shows a typical example of the efficiency 
correction result.
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4.5. Correction of true coincidence summing effect

Calibration sources used in gamma ray spectroscopy often contain 
60Co and 88Y, which emit multiple gamma rays with a high emission 
probability. When two or more gamma rays with sufficient energy to be 
detected are emitted simultaneously from a single radionuclide and are 
detected, the detector cannot distinguish between them and records 
the combined energy, leading to a reduction in the count rate of each 
individual gamma ray. This reduction is greater at shorter distances 
between the detector and source. If the reduction is outside the targeted 
uncertainty range, the measurement efficiency of the affected gamma 
rays must be compensated. To compensate for the true coincidence 
summing effect of 60Co and 88Y in the calibration source, a correction 
factor can be obtained through computer simulations or using the 
shape of the calibration efficiency curve.

Figure 10. Correction method for true coincidence summing effects

In this manual, we present a method to compensate for the true 
coincidence summing effects in calibration sources for gamma-ray 
spectroscopy using the shape of the efficiency curve, which is plotted 

where

 : Detection efficiency of k-gamma

 : Certified radioactivity of k-gamma

 : Emission probability of k-gamma

 : Net count of k-gamma

 : Measurement live time

 : Measurement real time

 : Half-life of radionuclides

 : Correction factors for k-gamma

 : Reference time for certificates

 : Reference time for the calibration

Uncertainty Evaluation
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Figure 12. Geant4 simulation

as energy. For gamma-ray energies above approximately 200 keV, the 
logarithmic efficiency, plotted as logarithmic energy, shows a straight 
line. This enables us to extend the efficiency of gamma rays emitted by 
radionuclides without true coincidence summing effects in the range 
200–700 keV up to 2000 keV, with some reduction in true coincidence 
summing effects at energies above 700 keV. 

Commercial computational programs, such as GESPECOR[7], that use a 
combination of semi-empirical and Monte Carlo simulations, and full 
Monte Carlo simulation codes, such as Geant4[8] and PENELOPE[9], can 
be used to calculate the peak efficiency, total efficiency, self-attenuation, 
and true coincidence summing effect of HPGe detectors. 

Figure 11. GESPECOR simulation
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• Soil and sediment

The soil(or sediment) first removes grass or other organic matter before 
manually picking up big stones and gravel. Use a sieve to do constitution 
if there are several tiny substances.

• Food

In an emergency, food samples are targeted at vegetables and fruits 
that may be contaminated. In the early stages of the accident, surface 
contamination of food is a major concern for radiation internal 
contamination of the target plant in the late stage. Since food may 
have been exposed to air deposition, sampling should be done on the 
upper section of the plant, or the edible part, and at locations such as 
marketplaces and distribution facilities. For foods, only the edible parts 
are sampled and then homogenized using a grinder.

Liquid samples are assumed to be homogenized and no further 
homogenization is required.

• Water

If the sample is to be stored for a certain period of time, add 11 M of 
hydrochloric acid at a ratio of 10 mL per liter of sample before or after 
sampling to prevent radioactive isotopes from being adsorbed onto the 
wall of the container.

To avoid cross-contamination, extreme radioactive contamination in 
water samples must be separated from other samples.

• Milk

In consideration of measurement time, milk samples are treated with 
preservatives to separate whey or prevent spoilage.

5. Environmental sample preparation

5.1. Considerations for sample preparation

The sample preparation area should be separated based on the 
contamination level of the samples, into areas for low- and high-
concentration samples. Disposable plastic should cover the work 
area, such as the floor or table, to prevent contamination and the area 
should be sanitized after any activity that could lead to contamination. 
All necessary tools should be prepared in advance, and workers 
must adhere to radiation protection rules for both internal and 
external exposure. In a logbook, the amount (mass or volume) of 
the environmental sample brought to the laboratory, the amount of 
the main sample after impurities removal, and the amount (mass or 
volume) of the net sample in the sample container should be recorded, 
along with information related to sample preparation, such as date, 
time, operator, and sample type. 

The prepared sample should be refrigerated before measurement, 
if necessary, and then wrapped in a clean plastic bag or plastic wrap 
before being placed in the detector. The measurement room, where 
the detector is installed must be separated from the sample preparation 
workspace. Once the measurement is completed, the sample is stored 
or disposed of in accordance with the regulations.

5.2. Sample preparation procedure

The measurement samples should be prepared through an 
appropriate homogenization process for each sample. Then transfer 
the homogenized sample to a measuring container up to the specified 
volume.
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⑤ Weighing (사진 교체 예정)

 

⑥ Sealing

 

⑦ Labeling

 

Measurement Sample Preparation Procedure

① Pretreatment of environmental sample

 

② Homogenization of environmental sample

 

③ Transfer of sample to a container

 

④ Addition of preservatives
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6. Sample measurement

6.1. System checking

In general, the position of the gamma-ray peak can shift, which can affect 
the analysis results of the spectrum. If a shift in the position of the target 
gamma-ray peak is identified (e.g., more than FWHM/3 or more than 2 keV 
of the gamma-ray peak), energy calibration should be performed again. 
The presence or absence of a peak shift can be determined by comparing 
the existing positions of specific gamma rays emitted by the background 
radiation or long-half-life radionuclides of the calibration source.

6.2. Background measurement

The measurement time for the sample spectrum was set in the range 
100–1,000 s in case of an emergency. Prior to the sample measurement, 
a background radiation spectrum was taken without any sample in the 
shielding. The background spectrum should be saved with a unique 
number for future reference and calibration of the sample measurements, 
and all relevant information must be recorded in the logbook.

6.3. Sample loading

To determine the measurement point in the shield, which is dependent 
on the detector-source distance, the point that maximizes the 
measurement efficiency (as close as possible to the detector–source 
distance) is first selected based on the specific sample container. 
The detector is then calibrated using a calibration source in the same 
container. This measurement point is used when the radioactivity level 
of the sample to be measured is low and high measurement efficiency 
is required. If the radioactivity concentration of the prepared sample 
is high, an additional measurement point is selected at a distance 

⑧ Storing of samples

 

⑨ Recording in Worksheet
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collection, and 5) the background spectrum.

② ��To prevent contamination of the detector, wrap the detector part of 
the shielding in plastic wrap. Place the container with the sample 
at the selected position, set the measurement time, and initiate the 
measurement. Check the relative dead time, and if it exceeds 10%, 
change the position to a previously calibrated position with lower 
measurement efficiency and perform the measurement.

 

③ �Save the measured spectrum with the ID of the sample and record 
the necessary information, such as the live time of the measurement, 
in the logbook. Check and record anomalies in the spectrum and 
peak shapes.

 

④ Repeat for all prepared samples.

from the detector to the sample, where the measurement efficiency is 
reduced by approximately 1/10 compared to the measurement point 
at a near distance. For sample containers with different capacities, the 
measurement points are selected and calibrated in the same manner 
when preparing for emergency measurements.

6.4. Sample measurement procedure

Before measuring the prepared sample, the detector used for the 
measurement should be calibrated for energy and efficiency according 
to the measurement conditions, such as the sample container, sample 
volume, and detector-to-sample distance. Once the calibration is complete, 
the settings and adjustments of the device and the measurement 
geometry should not be changed. If more than one measuring device is 
used, appropriate measures must be taken to ensure that each measuring 
device is not contaminated by the sample, and to distinguish between 
different levels of sample contamination. Therefore, it is essential for each 
laboratory to have a working procedure that reflects the detectors and 
measurement geometries used and to record all information about the 
sample and measurement conditions in a logbook.

The target value of the minimum detectable activity (MDA), which 
depends on the detector's measurement efficiency and time, is 1 Bq 
or less for major radionuclides (e.g., 661 keV for 137Cs and 364 keV for 
131I), and the target measurement uncertainty for major radionuclides 
is 10% or less.

Sample Measurement Procedure

① �In the detector’s logbook, record at least: 1) the sample type and 
unique number, 2) the sample container and detector geometry, 
3) the sample mass and medium, 4) the date and time of sample 
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for gamma-ray spectroscopy can easily obtain the radioactivity of the 
contaminating radionuclides in the measured sample by applying the 
calibration results to the program.

Each laboratory should have a well-defined procedure that outlines the 
calibration and sample analysis processes specific to the gamma-ray 
spectrometry computer program used in the laboratory. Furthermore, 
gamma-ray libraries for calibration and sample analysis should be 
routinely created for each gamma-ray spectrometry computer program 
used. 

The following is the model equation for determining radioactivity by 
gamma rays.

Gamma-Ray Specific Radiation Model Equations

• Radioactivity of k-gamma

• Net count correction factor

• Decay correction factor to the sampling time, 

• True coincidence summing effect correction to k-gamma

• Self-attenuation correction factor 

• Measurement geometry correction factor 

7. Radioactivity analysis

7.1. Analysis of measurement results

Most laboratories use computer programs for gamma-ray spectroscopy 
to facilitate calibration and sample analysis. The process of analyzing 
a measured sample spectrum in these programs involves several 
steps, including (1) applying an energy calibration to the sample and 
background spectra to subtract the gamma-ray count measured in 
the background spectrum from the sample spectrum, (2) obtaining 
the area (net count) of the user-specified gamma-ray peak, and (3) 
applying an efficiency calibration to calculate the radioactivity of the 
specified radionuclide. In this process, the radioactivity concentration of 
each radionuclide is automatically calculated using the measurement 
time (real-time and real-time) stored in the spectrum, half-life of each 
radionuclide provided by the gamma-ray library, probability of emission 
of gamma rays emitted by each radionuclide specified by the user, 
date and time of sampling and measurement, and amount (mass or 
volume) of the measurement sample entered by the user. Additionally, 
these programs enable various fine calibration functions and inputs for 
uncertainty calculations.

To facilitate calibration and analysis, computer programs for gamma-ray 
spectrometry create and use a gamma-ray library in the database that 
contains information on radionuclides, including their name, half-life, 
and uncertainty, as well as information on gamma rays emitted by the 
radionuclides, including gamma-ray energy, emission probability, and 
probability uncertainty. This gamma-ray library is built for the analyzed 
contaminating radionuclides expected to be contained in the sample 
and the gamma rays emitted by those radionuclides. Once the gamma-
ray library for sample analysis is established, the computer program 
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7.2. Corrections
7.2.1. Coincidence summing

The measurement sample may also contain radionuclides that 
simultaneously emit two or more gamma rays, such as 134Cs, which have 
a true coincidence summing effect similar to the calibration sources. 
The true coincidence summing effect is higher at closer detector-to-
sample distances, but the true coincidence summing effect usually 
decreases to 3% or less at detector-to-sample distances of 10 cm or 
more.

Figure 13. Decay scheme of 134Cs[6]

where,

 : Radioactivity of k-gamma

 : Detection efficiency of k-gamma

 : Emission probability of k-gamma

 : Net count of k-gamma

 : Measurement live time

 : Measurement real time

 : Half-life of radionuclides 

 : Correction factors of k-gamma

 : Reference time for sample measurement

 : Reference time for sample collection

 
If the identified radionuclide emitted multiple gamma rays, its 
radioactivity is to be determined using the weighted average of the 
gamma rays.

Multiple gamma-emitting radionuclide radioactivity and uncertainty

• Radioactivity of multiple gamma-emitting radionuclide 

• �Standard uncertainty of radioactivity of multiple gamma-emitting 
radionuclide 
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8. Recording results

8.1. Recording information
8.1.1. Sampling information

- Worker’s name

- Date of sample collection

- Sampling points

- Types of samples

- Sample collection methods

- Sample preparation type

- Measurement labs

8.1.2. Calibration information

- Worker’s name

- Detector type & ID

- Calibration source

- Measurement geometry,

- Calibration date/time

- Calibration result

8.1.3. Measurement

- Worker’s name

- Sample ID

- Measurement geometry

- Measurement date/time

- Measurement result

7.2.2. Self-attenuation in a Media

Sometime, it is difficult to obtain calibration sources that use the same 
medium as the measurement sample. Hence, relative self-attenuation 
between the measurement sample and calibration source is often 
unavoidable. If the effect of media differences is sufficiently significant 
to prevent reaching the desired measurement uncertainty, then it may 
be necessary to compensate for the attenuation effect to achieve the 
target uncertainty. 

The relative attenuation of the calibration source medium (usually 
water) by the medium of the measured sample depends on the distance 
between the detector and the sample. As the distance increases, the 
effect of attenuation decreases. This is because at a closer distance, the 
detector detects a wider range of anisotropic gamma rays emitted by 
the sample, whereas at a farther distance, the detector detects only a 
narrow range of isotropic gamma rays. This effect is most pronounced 
in the Marinelli beaker samples, where the thickness of the medium 
through which the gamma rays pass varies significantly.

Figure 14. Self-attenuation effect for various media
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Figure 15. Worksheet sample[2] 

8.2. Notation of data

All units used for recording and reporting are in the SI system. If 
necessary, they are indicated separately in parentheses.

The measurement results are recorded and reported as (measured 
value) ± (measurement uncertainty), and minimum detectable activity 
(MDA). The measurement uncertainty is approximately 95% confidence 
level, k = 2. If no radioactivity is measured, the measurement is reported 
as “< (MDA)” or “Not detected”.
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Appendix A. Utilizing GammaVision[10]

1. Preparation of Nuclide Library for Calibration

1) �Run the S/W ‘GammaVision’ to prepare the nuclide library for calibration.

2) Click ‘Library’, ‘Edit’, and ‘GammaVision Editor...’ in order in the S/W.

3) �Copy the existing nuclide library most suitable for calibration and 
load it in the ‘Editing:’ window.

 

4) �Modify the nuclide library by referring to the CRM certificate and the 
nuclear reference data designated by your institution.

5) �When the modification of the nuclide library is completed, save it for 
calibration.

2. Preparation of Nuclide Library for Sample Analysis

1) �Run the S/W ‘GammaVision’ to prepare the nuclide library for 
calibration.

2) Click ‘Library’, ‘Edit’, and ‘GammaVision Editor...’ in order in the S/W.

3) �Copy the existing nuclide library most suitable for sample analysis 
and load it in the 'Editing:' window.

 

4) Modify the nuclide library by using the information on samples.

5)� When the modification of the nuclide library is completed, save it for 
sample analysis.
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3. Energy Calibration

1) Check whether the measurement system is operating normally.

2) �When the system is ready, place the certified reference material (CRM) 
on the source holder.

3) Run the S/W ‘GammaVision’ to take a gamma-ray spectrum for CRM.

4) �Determine the measurement time (live time) so that the net count of 
the gamma-ray peak of interest is greater than 100,000.

① Click ‘Aquire’ and then ‘MCB Properties’ in the S/W menu.

② Click ‘Presets’ tab in the ‘Properties’ window and enter the live time.

  

③ �Make the distance between the detector and CRM the same as when 
measuring the sample.

5) Start data collection and obtain a gamma ray spectrum for calibration.

6) When data taking is finished, the spectrum for calibration is saved.

7) �Load the nuclide library for calibration by clicking ‘Library’ and ‘Select 
File…’ in turn.

8) �Press the ‘Energy...’ item in the ‘Calibrate’ menu to bring up the 
‘Energy Calibration’ window.

9) �Press the ‘Auto Calibrate’ button in the ‘Energy Calibration’ window 
to perform energy calibration.

10) �Click the ‘Energy' or ‘FWHM’ item in the ‘Fit’ area of the ‘Energy 
Calibration’ window to check the energy and energy resolution 
(FWHM) calibration results.

11) �When energy calibration is completed by closing the ‘Energy 
Calibration’ window, the ‘Energy...’ item of the ‘Calibrate’ menu is 
checked.

12) �Save the calibration result by clicking ‘Save Calibration...’ in the 
‘Calibrate’ menu.
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4. Efficiency Calibration 

1) �Click ‘Calibrate’ and ‘Efficiency…’ in turn. To calculate efficiencies of 
gamma-rays of interest, open the nuclide library for calibration and 
specify the corresponding gamma ray peak.

2) Click ‘Calc...’ in the ‘Efficiency Calibration’ window.

3) �Fill in the blanks of the ‘Efficiency Calculation Worksheet’ using the 
CRM certificate.

   

4) �Calculate the efficiency of the gamma-ray by clicking the activated 
‘Calculate Efficiency =’ button.

5) �Then click the activated ‘OK’ button to accept the efficiency calculation 
result.

6) �Calculate the efficiency for the remaining gamma-rays of interest in 
the same way.

7) �After completing efficiency calculations for all gamma rays of interest, 
select a function formula (e.g. ‘Polynomial’) in the ‘Mode’ area of the 
‘Efficiency Calibration’ window to create an efficiency fit curve.

8) �After exiting the ‘Efficiency Calibration’ window, click ‘Efficiency...’ of 
‘Calibrate’ again to check whether the efficiency fit curve was created 
well.

9) �If energy and efficiency calibration is completed, ‘Energy...’ and 
‘Efficiency...’ items should be checked when ‘Calibrate’ menu is 
clicked.

10) �Save the calibration result by clicking ‘Save Calibration...’ in the 
‘Calibrate’ menu.

5. Counting and Analysis for Sample Spectrum

1) Check whether the measurement system is operating normally.

2) When the system is ready, place a sample on the source holder.

3) �Run the S/W ‘GammaVision’ to acquire the gamma-ray spectrum for 
the sample.

4) �Determine the measurement time to satisfy the target MDA or 
measurement uncertainty.

5) �When the measurement is complete, save the gamma ray spectrum 
of the sample.

6) Recall the saved sample spectrum using the ‘Recall…’ menu of ‘File’.

7) �Apply the saved calibration result using the ‘Recall Calibration...’ 
menu of ‘Calibrate’.
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8) �Set the analysis conditions by pressing the ‘Analyze’, ‘Settings’ and 
‘Sample Type...’ menus in sequence.

9) �Load and apply the nuclide library for sample analysis by pressing 
the ‘Library’ and ‘Select File...’ menus in turn.

10) �Analyze the sample spectrum by clicking ‘Analyze’ and ‘Entire 
spectrum in memory…’ in sequence.

11)� Depending on the S/W settings, the analysis results are displayed on 
the screen or saved.
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Appendix B. Utilizing Genie 2000[11]

All GENIE-2000-related programs must always run the Virtual Data 
Manager (VDM) process before use. When Windows runs on the PC 
boot, VDM automatically starts and the corresponding icon is displayed 
in green. In order to prevent interruption (error) of VDM, screen saver, 
power saving mode, etc. are not set. Click Start Service if marked in red 
and contact the engineer if it does not start. And, MCA definition must 
be performed during the initial installation of equipment or during the 
replacement of MCA and PC.

1. Nuclide Library Editor 

The Nuclide Library Editor program is a program that allows users to 
generate their own gamma-ray nuclide library files. Create library files 
for analysis and library files for energy calibration.

1) �Run a program (Nuclide Library Editor): Run the Nuclide Library Editor by 
locating the installed path to generate the necessary nuclide library files.

2) A program for generating a nuclide library file is executed.

3) �Click Extract in the Options menu to select the desired nuclide.

4) �When the Extract Library Nuclides window opens, click the Open button
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5) �Pre-supplied *.Select the STDLIB.NLB file from the NLB file and click 
the Select button.

6) �Select the desired nuclide in the Extract Library Nuclides window and 
click the OK button. (multiple selections available)

7) ��Make sure that all of the selected nuclides are attached to the list 
pane at the bottom of the program, and then change the half-life, 
energy, and emission probability shown in the certificate.

8) Click Save as in the File menu to save the list as a library file.

9) ��Enter the file name (required), Description, and Optional, and press 
the Save button to save it 

10)� �Once the file is saved, you can check the file name stored at the top 
of the program.

11) �‘Local Disk (C:) ▶ GENIE2K ▶ CAMFILES’ You can check the file 
generated in the corresponding path.
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2. Energy calibration

1) �Energy full▶By Nuclide List in the File menu for energy calibration...
Click .

2) �Select the pre-created calibration library (*.NLB) file by pressing the 
▼ button on the Library in the Calibrate by Nuclide List window.

3) Select all Nuclides using the mouse and click the OK button.

4) �Mouse-click on the apex of the peak located at the front of the 
spectrum to locate the cursor.

5) �In the Energy Calibration – Full window, click Energy keV 59.54 and 
press the Cursor button.

6) �Verify that the channel value of the cursor corresponding to 59.54keV 
is substituted.

※ �In the case of 59.54 keV (241Am), it corresponds to about 163 channels 
when it is ‘8192 channels/3000 keV’.

7) �Then, in the same way, mouse click on the apex of the 60Co (1332.5 keV) 
peak.

8) �In the Energy Calibration – Full window, click EnergykeV 1332.49 and 
press the Cursor button.

9) �Verify that the channel value of the cursor corresponding to 1332.49 
keV is substituted.

10) �Click the Auto button to replace the channel values for the remaining 
energy. (It doesn't matter if you proceed manually)

11) �In the Energy Calibration – Full window, verify that all energy 
corresponding channel values are substituted.
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12) �You can check the Energy Calibration Curves by pressing the Show 
button.

13) �If the measured points are well substituted into the calculated line, it 
can be judged that the energy calibration is satisfactory.

14) �Click the OK button, and then click Save in the File menu to save 
energy calibration data.

15) �The last stored calibration data can be checked by clicking the 
Energy Show on the Calibrate menu.

3. Certificate File Editor

The Certificate file Editor program is used to generate a reference 
material certificate file for calibration. This must be done when using 
the nuclide library files and calibrating efficiency.

1) �Run a program (Certificate File Editor): Locate the installed path to 
generate the required certificate file and run the Certificate File Editor.

2) A program for generating a certificate file is executed.

3) �Click Library Extract on the Options menu to select the library file to 
apply to the file in the certificate.

4) �Select the library file to apply to the certificate and click the Open 
button.

5) Select the unit (Bq) listed on the certificate.

6) �Apply the radioactivity value (Activity) and % Uncertainty listed on the 
certificate by pressing the Input Change button.
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7) �Ensure that all applied nuclide library files are attached to the list 
window.

8) Enter Title, Quantity, and Assay date at the top.

9) �Click Save as in the File menu to save it as a certificate file when you 
have finished filling out everything.

10) �Enter the file name and optional description, and press the Save 
button to save it. 

11) �When the file is saved, you can check the file name stored at the top 
of the program.

12) �‘Local Disk (C:) ▶ GENIE2K ▶ CAMFILES’ You can check the file 
generated in the corresponding path.

 

4. Efficiency calibration

1) �Obtain a standard source measurement file of not less than 80,000 
seconds for efficiency calibration.

2) �Click Efficiency ▶ By Certificate file on the Calibrate menu for 
efficiency calibration.

3) �In the Open Certificate File window, select the pre-created certificate 
(*.CNF) file for efficiency calibration and open it.

4) �Make sure that all calibration energy (keV) is in the list of the Efficiency 
Calibration window.
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5) �Select 136.48 keV to calibrate the low-energy and high-energy regions 
separately and click the Cross Over button.

6) �Click the Auto button to enter the Efficiency and Error (%) values for 
all energy.

7) �Click the Show button on the Efficiency Calibration. Check the 
efficiency calibration curve.

8) �Click the List Pks button to check the Deviation value. In this case, if 
the Deviation (%) value falls within the range of ±5%, it is recognized 
as a satisfactory value.

9) �Click Store in the Calibrate menu to save efficiency calibration data 
as a file (*.CAL).

10) �File name (required input), Description, Eff in the Store window. 
Enter Geom. ID and click the Store button.

11) �Click Load on the Calibrate menu to apply the saved efficiency 
calibration file.

12) �* to be applied. Select the CAL file and press the Load button to 
apply the calibration file.

5. Identification of radionuclides

1) Click the Activate Report window icon to check the analysis results.

2) �Click Peak Location ▶ Unidentified 2nd Difference in the Analyze 
menu to find the peak in the measured spectrum

3) �Click Peak Area ▶ Sum/Non-Linear LSQ Fit Setup in the Analyze 
menu to determine the area of the located peak.
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4) �When analyzing radioactivity, select the same BKG file as the sample 
Geometry.

5) �Click Efficiency Correction ▶ Standard on the Analyze menu for 
efficiency correction.
※ Dual: Dual efficiency calibration calculations are performed.
※ Linear: The linear efficiency correction calculation is performed.
※ �Empirical: The efficiency correction calculation of the experiment is 

performed.

6) �Nuclide Identification ▶ NID w/ Interf. Corr… in the Analyze menu for 
nuclide discrimination/interference peak correction…click on.
※ NID library: Select the library file for analysis.




